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Create forms (forms) in Access 2016

Creating aform for your database can make data entry more convenient. When you create aform, you can
design it to match your database.

Creating a form for your database can make data entry more convenient. When you create a form, you can
design it to match your database.

In this lesson, you will learn how to create and modify forms. Y ou will also learn how to use form options such
as design control features and form properties to make sure the form works exactly the way you want.

Throughout this tutorial, the article will use a sample database. If you want to monitor, you can download the
Access 2016 sample database file. Y ou will need to install Access 2016 on your computer to open the example
file.

How to create a form (form)
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How to create aform

Access makes it easy to create forms from any table in your database. Any form you create from the table will
allow you to view the data already in that table and add new data. Once you have created the form, you can
modify it by adding additional fields and design control features such as combo boxes.

1. In the Navigation panel , select the table you want to use to create the form. You do not need to open the
board.
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2. Select the Create tab , locate the Forms group and click the Form command .

File Home Create External Data Database Tools Design Arran
“:' _ r _ _ r ':."___ L_I [ :\Form Wizard
; N ' Navigation ~
Application Table Table SharePoint Query Query Form Form Blank __
Parts ~ Design Lists -  Wizard Design L\s Design Form = More Forms -
Templates Tables Queries Forms

3. Your form will be created and opened in Layout view .

S customant | 5] Ondes
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(=24,
b Tracey Phone Mumber 919-555-23 14
Last Name Beckham City Raleigh
Add to Mailing List! Mo
Street Address 7 East Walker Dr, Camball |
NC Other Notes
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[=] © Paid * Pre Order - Mozes = Pickup Date -
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4. To save the form, click the Save command on the Quick Access Toolbar . When prompted, enter a name for
the form, and then click OK.

Save As ? X

Form Name:

Customers Form\ I

oK Cancel

About subform (subform)



If you created a form from atable where the content is linked to another table, your form may include subforms.
A subform is a data form that displays linked content in tabular format. For example, the subforms included in
the Customer s form that you created will display linked customer orders.

You do not need to include this subform because you may only want to use the Customers form to enter and
review contact information. If you find that you don't need a subform, you can easily deleteit. To do this, simply
click on it and press the Delete key on your keyboard.

) customent
1 Customers
7 East Walker Or. Add 1o Mailing List? | Neo
State N Qther Notes
27612
1=} > Paid = Pre Order - Motes = Pickup Date =
38 Yes Me 12724113
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However, subforms are often quite useful. Depending on the content and source of the form, you may find that
the subform contains useful information, as in the example below. In the Orders form , the subform contains
the name, quantity, and price of each item in the order. That's all useful information.

=MNew Order

Customer Whitman ¥| Order# |5 Pickup Date  12/4/13

N Oere ©

Paic
3Add ltem

Category ~ Product » Quantity ~ "Unit® - Price -1 Subtoml - +
Cookies Chocolate Chip 2 Single $1.50 $3.00
Cookies Fudge Brownie | Single $2.00 $2.00
Cookies Ginger Shortbread 1 Half-Dozen $10.50 %1050
Pastries Brownies | One Dozen £19.00 $19.00
Cakes Black Forest 5 Single $22.00 $110.00
Cakes Coconut 2 Single $22.00 $44.00
Cakes Carrot Cake | Sinele £22.00 32200

Add additional fieldsto theform

When you use the Form command on an existing table, al fields from the table are included in the form.
However, if you later add additional fields to the table, these fields will not automatically show in the existing
forms. In situations like this, you can add additional fieldsto aform.

How to add a field to the form



1. Select the Design tab , then locate the T ools group on the right of the Ribbon.

2. Click the Add Existing Fields command.

Design Arrange Format @ Tell me what you want to do... Olenna Mason
wl | aae =g —
5 =5 |~} = T g 1 3
) = _ Title
@ . Inset  Fnate and Time (GIEXiSting Property
mage Fields % Sheet
Controls Header / Footer Tools 1y

3. The Field List control panel will appear. 4. Double-click the desired field ().



Field List

+

Show all tables

Fields available for this view:

1D
First Name
Last Name
Street Address
State
Zip Code
Email
Phone Number
City
Add to Mailing List?
Other Notes

e

4. The field will be added.



—1 Customers

D Email beck@email.com
EOtIn:' Motes

First Mame Tracey Phone Number 919-555-23 14
Last Mame Beckham City Raleigh

Y ou can also use the above procedure to add fields to a completely blank form. Just create the form by clicking
the Blank Form command on the Create tab , then follow the steps above to add the desired fields.
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! ! ! 1 [l& [ - Form Wizard
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' ' i |12 B = Navigation ~
Table Table SharePoint Query Query Form Form Blan
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How to add afield from another table

Y ou can aso add fields from different tables in your database to the form.
1. Fromthe Field List control panel , click Show All Tables.

2. Click the plus sign + next to the table containing the field you want to add, then double-click the desired field.
New fields will be added.
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Add design control features

Design control features set restrictions on the fields in the form. This gives you greater control over how datais
entered into your form, thereby helping to keep your database consistent.

Combo box

A combo box is a drop-down list you can use in your form instead of a field. The combo box limits the
information that users can enter by forcing them to select only the options you have specified.

A useful combo box for schools with a limited number of valid responses. For example, you can use combo
boxes to ensure people only enter a valid state in the United States when entering an address or just select
products that already exist in the database.

How to create a combo box



1. Inthe Form Layout view , select the Design tab , then locate the Controls group .

2. Select the Combo Box command , which looks like a drop-down list.

Arrange Format  Q Tell me what you want to do...

) [@ &5 L;'% g

Controls

<
§

3. Select the desired location for the combo box. A line will appear, indicating the location where your combo
box will be created. In this example, it will be placed between the City field and Add to Mailing List.

Phone Number 919-555-2314
City Raleigh

_1
Add to Mailing List? |No E5

4. The Combo Box Wizard dialog box will appear. Select | will type in the values ??that | want , then click
Next.

Combo Box Wizard

This wizard creates a combo box, which displays a list of values you
can choose from. How do you want your combo box to get its
values?

OI want the combo box to get the values from another table or
query.

(g will type in the values that I want.

Find a record on my form based on the value I selected in my
combo box.

Cancel Back Next >

5. Enter the options you want to appear in your drop-down list. Each option must be on its own row. This
example is creating a combo box for the Add to Mailing List field? in the form, so we will enter all possible



valid responses for this school. Users will be able to select one of three options from the completed combo box:
No, Yes- Weekly and Yes - Special Eventsand Offers.

Combo Box Wizard
What values do you want to see in your combo box? Enter the number of columns you want in
the list, and then type the values you want in each cell.
To adjust the width of a column, drag its right edge to the width you want, or double-click the
right edge of the column heading to get the best fit.
Number of columns: [1_
i Coll
No
Yes - Weekly
& nts and Offers I
*
Cancel < Back Next > Finish

6. If necessary, change the column size so that all of your text is displayed. When you're happy with your listing,
click Next.

Combo Box Wizard

What values do you want to see in your combo box? Enter the number of columns you want in
the list, and then type the values you want in each cell.

To adjust the width of a column, drag its right edge to the width you want, or double-click the
right edge of the column heading to get the best fit.

Number of columns: [1_

Coll +

No
Yes - Weekly
‘'es - Special Events and Offer:

Cancel < Back Next > Finish

7. Select Store that value in this field , then click the drop-down arrow and select the field you want to select
from the combo box recorded. After making your selection, click Next.



Combo Box Wizard

Microsoft Access can store the selected value from your combo box
in your database, or remember the value so you can use it later to
perform a task. When you select a value in your combo box, what
do you want Microsoft Access to do?

OBemember the value for later use.

(@ Store that value in this field: | -

D

First Name
Last Name
Street Address
State

Zip Code
Phone Number

Ci
Add to Mailing List?

Cancel < Back Next > Finish

8. Enter the label - or name - that will appear next to your combo box. In general, you should use the name of
the field you selected in the previous step.

Combo Box Wizard

What label would you like for your combo box?

[Add to Mailing List? I

Those are all the answers the wizard needs to create your combo
box.

Cancel < Back I

9. Click Finish. Your combo box will appear on the form. If you created a combo box to replace the current
field, you should delete the first field. In this example, you may notice that there are now two fields with the
same name. These two fields send information to the same location, so we don't need both. | will delete the one
without the combo box.




Phone Number 919-555-2314

City Raleigh
Add to Mailing List? v
No

Yes - Special Events and Offers l! _

Other Notes

10. Switch to the Form view to check your combo box. Just click the drop-down arrow and verify that the list
contains the correct choices. Combo boxes can now be used to import data.

Combe Box Wizard

This wizard creates a combo box, which displays a list of values you
cen choose from. How do you want your combo box to get its
values?

ﬁ;\)] want the combo bax to get the values from another table or
Auery.

(O T will type in the walses that T want.

()Flr‘d a record on my form based on the value I selected in my
~ combeo box,

~ i Tracey Beckham ?19-555-2314 ~
bt Lucinda George 919-555-4534
Jerrod Smith 919-555-4564

Cancel

Chloe Jones 3 919-555-8658
Quinton Bbyd 919-555-5112
¢ Na Alex Hinton 919-555-5460
Nisha Hall 919-555-5753

If you want to include a drop-down list with a variety of options and don't want to import them all, create a
combo box and select the first option in the Combo Box Wizard: | want to get the values ??from another
tableor query . Thiswill allow you to create a drop-down list from afield in the table.

Some users report that Access is having trouble working with the form. If you have trouble performing any of
the Layout views, try switching to Design view .

Customize the form settings with the Property Sheet

The Property Sheet is a control panel containing detailed information about your form and its components.
From the Property Sheet, you can make changes to every part of the form, both in function and interface.

The best way to familiarize yourself with the Property Sheet is to open it and select the options in it. When you
select an option, Access displays a brief description of the option on the bottom left border of the program
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~ Property Sheet

Selection type: Text Box
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format Data Event Other

Format
Decimal Places
Visiblei‘\
Show Date Picker
Width

Height

Top

Left

Back Style
Back Color
Border Style
Border Width
Border Color
Special Effect
Scroll Bars
Font Name
Font Size

All

Pay attention when you modify your form and its fields. You can make subtle changes to the Property Sheet.
Because there are so many options, it can sometimes be difficult to remember which ones you used to modify

each aspect of the form.

Modify form settings

There are too many options in the Property Sheet to discuss in detail all within this article. The article will only
look at two useful items here: The Hiding and Setting field comes with the Dates option to automatically fill in
the current date. Practicing these processes will also help you understand how to work with other Property Sheet

settings.

How to hideafield

1. In Layout or Design view , select the Design tab , then find the Tools group . Click the Property Sheet

command .

Design Arrange

Controls

2. Property Sheet will appear in the right panel. On the form, select the field you want to hide. In this example,

Format

Q Tell me what you want to do...

7 Date and Time

4

Add Existing Property

Fields Sheet[:;
g

Header / Footer Tools

we will hide the Customer 1D field because we do not want any user to try to edit it.



3 Customers1 3 Orders . prOperty Sheet ®

=1 CUS‘tO mers Selection type: Text Box
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» Text Format
Datasheet Caption
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3. Inthe Property Sheet page, click the All tab , then find the Visible option on the fifth row.

4. Click the drop-down arrow in the right column, then select No.

Property Sheet 2

Selection type: Text Box

1D v

Format Data Event Other All

Mame 1D A
Control Source ID

Format

Decimal Places Auto

Visible v
Text Format Yes

Datasheet Caption W
Show Date Picker For dates

Width 3.1514°

Height 0.6097"

Top 0.25"

Left 1.6146"

Back Style Mormal

Back Color Background 1

Border Style Solid

Border Width Hairline

Border Color Backaround 1, Darker 35% ¥

5. Switch to the Form view to verify that thefield is hidden.
How to set thefield to automatically fill in the current date

1. In Layout or Design view , select the Design tab , then find the Tools group . Click the Property Sheet
command .

2. Property Sheet will appear in the right panel. On the form, select the school you want to automatically fill in
the current date. This must be a field with a date data type. The example in this article will select the Pickup
Datefield onthe Ordersform.



Property Sheet #
-
Selection type: Text Box
L Pickup Date £
Format  Data  Event Other  All
Visible Yes 1 1PN
Taxt Format Plain Text
s PiC!{Up Date ) Datasheet Caption
{k Show Date Picker For dates
Width 083337
OPpre Order Height 0.25°
Top 1
O Paid Left 6.125°
Back Style Mormal
Back Color Background 1
Border Style Solid
Border Width Hairline

3. Inthe Property Sheet, click the Data tab , and then select the Default Value field in the fourth row. Click the
Expression Builder button that appears in the column on the right.

Property Sheet X

Selection type: Text Box

Pickup Date v

Format Data  Event Other  All

Control Source Pickup Date
Text Format Plain Text
Input Mask

Default Value | &
Validation Rule
Validation Text

A

Filter Lookup Database Default
Enabled Yes
Locked No

4. The Expression Builder dialog box will appear. In the Expression Elements list , click on the words
Common Expressions.

5. In the Common Expressions list, double-click Current Date.



Expression Builder X

Enter an Expression to define the control property value:
(Examples of expressions include [fieldl] + [field2] and [field1] < 5)

Date() | oK
Cancel
Help
<< Less
Expression Elements Expression Categories Expression Values
+3 Orders Current Date
+® Functions Current Date/Time
+/@ Access2016_SampleDatabase.ac
% Constants
% Operators

£ Common Expressions

6. The expression for Current Date will be added. Then, click OK.

Expression Builder X

Enter an Expression to define the control property value:
(Examples of expressions include [fieldl] + [field2] and [field1] < 5)

Date() ! | oK
Cancel
Help
<< Less
Expression Elements Expression Categories Expression Values
+ Orders Current Date
+ % Functions Current Date/Time
+18 Access2016_SampleDatabase.ac
% Constants
% Operators

£ Common Expressions

7. Switch to the Form view to verify that the expression works. When you create a new record with that form,
the modified date field will automatically fill in the current date.
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Customer ~| Order# #### Pickup Date 4/1/16
MNotes OPre Order
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Practice!

Open the practice database mentioned above.

Create the form from the Customer stable .

Delete subforms.

Create a combo box. Add the following options to the combo box:

Raleigh

Durham

Hillsborough

Cary

Chapel Hill

Garner

. Charlotte

5. Storethe valuein the City field and label the combo box as NC City List . Click Finish when you are
done with the Combo Box Wizard.

6. Switch to Form view and click the drop-down arrow in the combo box you created. Y ou will see the list

of cities.
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See more;

1. Create data queriesin Access 2016 from simple to complex
2. Edit tablesin Access 2016
3. Work with datain Access 2016

Y ou finished reading the article "Create for ms (forms) in Access 2016" edited by the TipsM ake team. We
hope this article has provided you with many useful tech tips and tricks. Y ou can search for similar articles on
tips and guides. Thank you for reading and for following us regularly.
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